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Hereby, Bentel Security,
declares that the above mentioned B-TEL2 is in compliance
with the essential requirements and other relevant provisions of Directive 1999/5/EC.
The complete R&TTE Declaration of Conformity for each Panel can be found
at www.bentelsecurity.com/dc.html.
This device complies with CEI 79-2 2a Ed.1993.
Installation of these systems must be carried out strictly in accordance with the instructions
described in this manual, and in compliance with the local laws and bylaws in force.
The above mentioned BTEL99 has been designed and made
to the highest standards of quality and performance.
The manufacturer recommends that the installed system should be completely tested
at least once a month.
BENTEL SECURITY srl shall not be responsible for damage arising
from improper installation or maintenance by unauthorized personnel.
BENTEL SECURITY srl reserves the right to change the technical specifications
of this product without prior notice.
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INTRODUCTION
GENERAL FEA
TURES
FEATURES
Vocal and digital dialer
 4 independent alarm channels with priority management.
 Option to control Stop Alarm and Listen-in features remotely by entering a PIN into the remote telephone
keypad.
 Option to associate up to three voice messages for every event, with four message choices:
z two messages, each 32 seconds long;
z four messages, each 16 seconds long;
z one 32 second long message plus four messages, each 8 seconds-long;
z eight messages, each 8 seconds long.
 Built-in multiprotocol digital communicator.
 Programmable alarm-call activation by positive drop or negative command.
 Programmable PIN to Stop Alarm via device keypad.
 8 programmable telephone numbers.
 Protection against accidental battery polarity inversion.
 Battery and system status checks.
 255-element logger (event register).
 Programming by software or keypad.
 Superkey function.
 2 programmable OC (Open Collector) outputs.

Telephone line






Test for telephone line cutting.
Signals telephone line failures on an Open Collector output or with a speaker tone.
Excluded line tone control.
Overvoltage protection.
Programmable tone or pulse dialing.

Interface





Digital message recording/playback.
Built-in speaker for message playback.
Single-digit LED display.
Alphanumeric command keypad.

Box
 Tamper protection (anti-opening and anti-tearing).
 Compartment for 12 V – 1.2 Ah battery (not provided).

DESCRIPTION
Telephone dialers are signaling devices that can call and send pre-recorded messages to a series of programmed telephone numbers.
The B-TEL2 dialer is available in a plastic box (ABS) that can be attached to the exterior of the control panel to which it must be connected.
The dialer is designed to operate 4 channels, and thus control 4 distinct events (such as the burglar and fire alarms). Alarm messages can be
associated with each channel.
These messages are recorded in the solid-state memory, avoiding the problems associated with using magnetic tape, including: loss of message
quality over time, mechanical hitches after long periods of inactivity, etc…
An internal speaker allows one to check the quality and accuracy of recorded messages.
Programming all the typical parameters of this device is simplified by the use of an alphanumeric keypad and LED display. The device can also
be programmed with the appropriate software.
) All programmed data (including alarm messages) are stored in the non-volatile memory for an indefinite length of time, even
when power is not present.
The plastic box is provided with tamper protection (against unauthorized openings) and optional anti-tearing protection. The box can house a 12
V - 1.2 Ah battery
4 Channel telephone dialler
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INSTALLATION
MOUNTING
This paragraph describes how the B-TEL2 is installed.
 Numbers in bold type between brackets [ ] refer to parts in Figure 1, except when otherwise
indicated.
When choosing the location to install the dialer, keep the following considerations in mind:
 it is recommended that the dialer be installed at a height of about 160cm. This height will not only facilitate
keypad and microphone access, but also make it easier to view the display;
 ensure that there are no water pipes or electric cables present where the holes for attachment will be
drilled. Once the installation location has been chosen, lay the wires between the dialer and the devices to
which it will be connected. Proceed with the attachment as described in the following (refer to Figure 1 to
identify the parts mentioned).
1. Remove the front panel by unscrewing the four screws [1].
CAUTION - After the dialer is installed, it may be necessary to remove the front panel for maintenance or repair
purposes. Bear in mind that if the tamper switch is connected to the corresponding line of an anti-intrusion
system, the latter can cause an undesired alarm. Therefore, before removing the front panel of the dialer, make
sure that the panel's alarm group is disabled (refer to the control panel's instructions for information on how to
disable the alarm group).
2. Pass the connection cables through the opening [8] and mount the dialer using the holes [3].

DESCRIPTION OF THE TERMINALS
1-2 [L.E.] External telephone line. Connect the external telephone line to terminals 1-2 [L.E.]. The dialer must
be connected before all other telephone devices that will share the same line (these devices are connected
to terminals 3-4 [L.I.]).

As required by active laws and regulations, terminals 1-2 [L.E.] must be connected to the telephone
line by means of the appropriate plug or a telephone commutator
CAUTION - Do not connect telephone devices parallel to terminals 1-2 [L.E.]
3-4 [L.I.] Internal telephone line. These terminals are used to connect other devices that will share the line
(telephone exchanges, telephones, fax, modem, etc.).

the event of an alarm, the dialer will use the telephone line to which it is connected for the time
necessary to carry out the programmed call cycle.
5 [-] Ground
CAUTION - As required by telecommunication systems safety standards, the 5 [-] terminal must be connected
to the ground of the electrical circuit to protect the dialer from overvoltage on the telephone line.
6-7 [A.S.] Tamper. These terminals are connected to the tamper switch [14] and are normally closed. They
open when the box's front panel is removed (anti-opening protection). Connect these terminals to the
tamper line of the security system control panel.
9-10 [O1][O2]

Open-Collector Output. OC (Open-Collector) output.

CAUTION - During a power failure, no voltage will be present at the [+12] terminal. In order to continue powering
loads, draw the voltage directly from the battery's positive terminal.
11-12-13-14 [L1][L2][L3][L4] Alarm channels. Normally, these terminals must be connected to Positive.
When Positive drops, the dialer will call the telephone numbers and playback the alarm message associated
with that alarm channel.
IMPORTANT - Channel #1 is prioritized over other alarm channels. If channel #1 is activated, the channel
#1 call cycle will be performed, even if the dialer has already begun another channel's call cycle.
15-16 [+12] [M
M] Power supply. The dialer can be powered by two different voltages, 13.8 Vcc or 27.6 Vcc.
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CAUTION - Before applying voltage to terminals [+12] and [M
M], ensure that the jumper [18] is correctly
positioned.

BASIC CONNECTIONS
The basic connections are necessary for dialer function. They are illustrated, with the channels highlighted, in
Figure 3. In the connection example, alarm channel L1 is connected to the normally closed contact (NC) of the
burglary system and receives, under normal conditions, the positive input voltage.
) The dialer's default programming allows for activation by the absence of the positive signal ('Positive drop',
factory setting, see jumper [16]). Should this setting change (activation with a 'Negative command') the
alarm channel must be connected to a ground output in the event of an alarm (for example, Open-Collector).

Y CONNECTIONS
A UXILIAR
UXILIARY
The dialer does not require auxiliary connections in order to function. However, these connections provide
many useful options. All auxiliary connections are shown in Figure 3 and described in the following paragraphs.
Tamper - Connection to tamper line terminals allows detection of possible attempts to tamper with the dialer
box. In Figure 3, these terminals are connected in series to the security system tamper line.
Connection to other devices - The B-TEL2 is provided with 4 alarm channels. Channel 1 can, for example, be
used to connect the alarm relay of a fire-protection system (as shown in the example), or the anti-theft alarm
relay of a burglary system (connected to Channel 2 in the example) or a radio-receiver relay (telecare).
Interrupt alarm cycle - An alarm channel can be used for the Stop Alarm function. For example, a momentary
positive activation of the 14[L4] terminal can interrupt the alarm cycle already underway (see also "Stop Alarm"
in the PROGRAMMING chapters). In order for this feature to function, Channel L4 must be programmed (by
software or keypad) as "Positive command".

ATION POLARITY
A CTIV
CTIVA
The dialer can be activated with positive or negative polarity signals (as specified in Table 2). To set activation
polarity, move the jumper [16] (see Figure 1). The dialer is factory-set to be activated with positive polarity
signals.
Activation mode can be programmed via software or keypad. Keep the following considerations in mind:

H With + polarity: dialer is activated by the application of a positive signal (positive command).
With - polarity: dialer is activated by the lack of a negative signal (negative drop).

L With + polarity: dialer is activated by the lack of a positive signal (positive drop).
With - polarity: dialer is activated by the application of a negative signal (negative command).
CAUTION - When using positive command signals with a voltage higher than 20 V, it is necessary to
connect to a 10Kohm resistor (not provided): see Fig. 4.
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PROGRAMMING BY PC
This chapter describes how to program the dialer with a PC. A PC can be used to set all the parameters necessary
for dialer operation, as well as modify the dialer's operations to suit the user's specific needs and installation.
This chapter also describes in detail all the parameters that can be programmed by the installer and the user.
A particular cable (GSM/LINK) is also needed to program the dialer by PC. The cable diagram is shown in Figure
2. This cable is connected between the PC's RS232 serial port and the connector [10], present on the dialer's
board.
Once the PC is connected to the dialer, the software application can be launched and the programming performed,
as described in this chapter.

MAIN WINDOW
Once the application is launched, a window similar to the one shown in Figure 4 will appear. This paragraph
describes all of the window's components.
Menu Bar - This bar contains all the different menu items used not just to program client data, but also to
manage several important PC settings.
Bookmark Bar - The settings of multiple clients can be kept open at the same time (see menu File -> Open...).
One can use the bookmark bar to instantaneously recall the settings of an open client: simply click on the
corresponding "bookmark". Once the "bookmark" is selected, the right mouse key can be clicked to save data
or close the client profile. Be sure to save all client data or changes before closing.
button to set client data (name, phone, address, etc.). The Account Code
Client Info Button - Click on the
is a meter that advances automatically. This parameter does not keep track of deleted clients: therefore one will
be assigned the first free number by clicking on the

button.

Send/Load All Button - With a single click, these buttons can load all parameters programmed into the dialer
to the PC memory (Board Load, green arrow button,

) or send all client programming to the dialer’s memory

(Send to Board, red arrow button,
).
Choose Programming Page Window - Various programming pages can be selected from this window. When
a page is selected, a series of data to program will appear in the Parameters Area.

 Page names may not always be visible. Click on the Client Bar to view page names.
Parameters Area - This part of the window shows all parameters that can be programmed. Parameters are
grouped according to the page selected and are sorted into sections to facilitate data input. See the
PROGRAMMING paragraph for a detailed description of these parameters.




 


   
  



 

 

 

Fig. 4 - Main window
4 Channel telephone dialler
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FILE MENU
Items in the File Menu include the following:
New
Create a new client. It is recommended that one assign and save a new name for each client.
Save

Save all of a client's settings, changes, and data to memory.

Open

Open a client's data and settings.

Close

Close out of all client information. Be sure to save all changes before closing.

Export Data

Export the selected client configuration to file.

Import Data

Import the client configuration previously saved under Export Data.

Exit

Close the program and exit.

 One can also perform Save and Close commands by right-clicking the mouse on the Bookmark Bar.

OPTIONS MENU
This menu contains the parameters and options for correct program operation. Items in the Options Menu are the
following:
Serial Ports Sets the serial port (RS232) to connect to the dialer through the GSM/LINK wire, as well as the
number of connection attempts (preset at 3 attempts).
Language

Allows one to select the application's default language from those available.

TION MENU
COMMUNICA
COMMUNICATION
Firmware Upgrade

Quickly and easily upgrades the dialer's firmware. Once the new firmware is obtained from
the .HEX file, it can be loaded and sent to the dialer by pressing the
button.

PROGRAMMING
The following paragraph describes in detail all the programming pages and their relative parameters.
Send and Load buttons: Except for the Messages Page, all programming pages show the two buttons
data from board, green arrow) and

(Load

(Send data to board, red arrow). On the Log page, only the Load button

is present. Even though they look the same as the buttons in the Select Programming Page window, the action
range of these two buttons is limited exclusively to the parameters of the single page currently displayed on the
screen.

Phonebook Page
Up to 8 telephone numbers, each 20 digits long, can be programmed on this page. To program one (or more)
telephone numbers, select the corresponding line from the list on the left and enter the data on the right.

 To select more numbers, click on the table row while holding down the Control key on the PC keyboard. To
select a continuous series of numbers, select the first number and, holding down the Shift (or Maiusc) key
on the PC keyboard, the last number.

Description - Enter the description for the selected telephone number in this box.
Telephone number - Enter the telephone number in this box (enter only numbers).
Behaviour - Select the use for which the phone number is programmed. To disable the phone number
(leaving it in the memory for future use) select the None option.

Telemonitoring - This section is only available if Telemonitoring is set in the Behaviour section. Click the
Protocol box to select one from those available. Every Telemonitoring protocol requires a 4-digit User PIN (5
digits for CESA protocol).

Button

- Click this button to select all telephone numbers on the list. Alternatively, clicking on the triangle

to the right, one can deselect the numbers.

 Programmed telephone numbers will appear in the table with a different color, as explained in the Legenda
section
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Outputs Page
The parameters for the dialer’s two outputs are programmed on this page.

 To set or cancel options, double-click the appropriate box.
Active state - The state of the non-operating output is programmed in this box:
= Open-Collector Normally Open.
= Open-Collector Normally Closed.

G

PSTN fault - If chosen, the output will be activated in the event of a telephone line failure.
Mains fault - If chosen, the output will be activated if power is missing for at least 15 minutes.
Low battery - If chosen, the output will be activated in the event of insufficient battery level.
FTC - If chosen, the output will be activated if a call is not completed properly.
Call routing - If chosen, the output will be activated when the dialer performs a phone call.
One way audio - If chosen, the output will be activated when listen-in is activated.
Remote control - If chosen, the output will be activated when the user uses remote commands.
Monostab. - If chosen (marked by the check ' symbol), the output will, upon activation, remain active for a set
length of time (ON Dur.). Once this time is completed the output will return to the non-operating state.

ON Dur. (sec.) - This box is active only if the Monostab. Option is selected. Specify the monostable time from
1 to 240 seconds by clicking the mouse on the arrow that appears near the number.

Events/Actions Page
Actions the dialer must carry out in response to specific events or actions are programmed on this page.
Telephone numbers - Select one or more telephone numbers that the dialer will call when one of the events
listed in the Description column occur. These telephone numbers are programmed on the Phonebook Page.

 To select a number, click the appropriate box. The check sign ' will indicate that the telephone number has
been selected.

 The Mains fault event occurs only if power is missing for at least 15 minutes.
C-ID - Telemonitoring Contact ID PINs (3 digits) are programmed in this column.
SIA - SIA Telemonitoring PINs (2 digits) are programmed in this column.
 To set the Telemonitoring PINs, click the appropriate box twice and enter the PIN.
Mess. # - Up to 3 voice messages can be sent when an event or action listed in the Description column occurs.
 To select a message, double-click the appropriate box and choose the message from those available.

Options Page
The options and parameters for correct dialer operation are programmed on this page.
Selection - Click on the appropriate boxes to disable DTMF tone control, select tone dialing, or select pulse
dialing.
Start playing after - manner in which a dialer sends a voice message is programmed in this section.
z If Selection, is chosen, the message will be sent after the remote telephone sends a response signal.
z Voice on-line, is chosen, the message will be sent after the remote operator responds.
z Delay, is chosen, the message will be sent after the timed delay, programmable from 0 to 99 seconds. Set
the delay time by clicking the arrow next to the number, or clicking on the box and manually inserting the number
of seconds.
Vocal messages - The parameters for voice messages are programmed in this section. These parameters
are:
The number of times each message is repeated (minimum 1, maximum 9),
The duration and number of messages as specified in the following:
2 messages = two messages, each 32 seconds long (factory default);
4 messages = four messages, each 16 seconds long;
1 + 4 messages = one 32 second long message and four 8 second long messages;
8 messages = eight messages, each 8 seconds long.
A brief description can be written for each voice message by clicking on the message box.
General options - The dialer's general options are programmed in this section, described as the following:
z Number of rings - The number of rings after which the dialer answers the phone (if able to do so). If the
installer has enabled the Bypass answering machine option, this option will be ignored.
z Call attempts - Number of times a call will be attempted in the event it is not properly completed.
z Tone on PSTN fail - The dialer normally shows the presence or absence of the phone line on its display.
4 Channel telephone dialler
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When this option is selected, the dialer will emit a sound signal if there is a PSTN line failure. When this option
is deselected, the dialer will show the PSTN line outage, but will not emit a sound signal.
z Confirm call result - When this option is selected, the dialer will wait for confirmation from the remote user

before sending the voice message. The remote user will send confirmation by pressing the  key of the
remote telephone keypad (valid only for touch tone telephones).
z One way radio - When this option is selected, a listen-in session will automatically begin after the cycle of
electronic surveillance messages is sent.
z Call all telemonitoring numbers - When this option is selected, all calls to electronic surveillance programmed
for a single event will be performed. If this option is deselected, the dialer will end electronic surveillance calls
as soon as one is completed properly.
z Call all voice messages numbers - When this option is selected, all voice calls programmed for a single
event will be performed. If option is deselected, the dialer will end voice calls as soon as one is completed
properly.
z Bypass answering machine - This option allows the dialer to share the telephone line with another responding
device (voicemail, fax, etc.). Select this option and the dialer will immediately respond after the first ring, if a single
ring was detected within the last minute.
Codes - In this section, the Installer PIN (Master) and/or User PIN (Slave) needed to perform the necessary
programming are entered. It is possible to enter PINs of at least 4 up to 6 digits.
Inputs - The input channel and stop alarm channel activation modes are programmed in this section. For
more information, read the ACTIVATION POLARITY paragraph in the INSTALLATION chapter.

 Double-click the appropriate box to set the mode.

Voice messages Page
Voice messages are programmed on this page. The number and duration of messages are set in the Options
Page.
PLAY Button - Press this button to listen to the voice message.
REC Button - Press this button to start recording a new voice message.
STOP Button - Press this button to stop recording or listening to a voice message.

 A real-time timer will show the elapsed time while recording or playing a message.

Log Page
On this page, pressing the

button allows one to see the list of the last 255 events that occurred.

It is possible to export the displayed list into a file just pressing the button

13
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PROGRAMMING BY KEYPAD
The dialer's keypad can be used to set all the parameters necessary for dialer operation, as well as modify the
dialer's operations to suit the user's specific needs and installation.
The appropriate software or the dialer's keypad, with the auxiliary display, can be used to program these
parameters. When programming by keypad, the parameter is selected by pressing a series of keys.
The value for that parameter is then entered.

INTRODUCTION
Restore Factory Settings
To restore all factory settings, remove all power supplies, hold down the
replace the power supplies.

, ,  and  togheter, and then

Access Programming Mode
In order to program parameters by keypad, an Installer PIN must be entered via the keypad in the following
manner:

 <Installer PIN> 
where <Installer PIN> is a number 4 to 6 digits long. The factory-set installer PIN is 0001.
The device will indicate that it has successfully entered programming mode with a letter

P on the display.

 If a PIN longer than 6 digits or an incorrect PIN is entered, the speaker will emit an error sound (boop).
 If,

at any point during programming, 5 minutes elapse without a key being pressed, the dialer will
automatically exit programming mode.

Programming values
Unless otherwise indicated, values are programmed in the following manner:

 <Section Number>  <Value> 
where <Section Number> is a 3-digit number and <Value> is the data to be programmed. For a complete list
of sections, refer to Tab. 3.
When the

 key is pressed, the letter b will appear on the display.

At this point the value relative to the section

being programmed can be entered.



If the
key is pressed again while the <Section Number> is being entered, dialer will exit the section and
return to the standby state

Confirm programmed values
Press the

 key to confirm and store the entered value.

Deleting a value

 key will delete the last digit entered (currently shown on the
display). When the correct digit is entered, it will appear on the display in the place of the incorrect digit. If the 
When programming a value, pressing the

key is pressed repeatedly, it will advance until it reaches the beginning of the entered value, without exiting from
the section.

4 Channel telephone dialler
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Display programmed values
View the value of a previously programmed section in the following manner:

 <Section Number> 
where <Section Number> is a 3-digit number.
If, for example, one wishes to view the third telephone number programmed (section 103, see Table 3a), the
following procedure will be used:

 to select the section;

to select the third telephone number;
 to view the requested value, which will be shown on the display in sequence, figure by figure, at regular
intervals. After a value is viewed, or if the section does not contain any programmed data, the dialer returns
to the standby state.

Firmware revision
Find out which revision of B-TEL2 firmware the board is using by entering the programming phase and keying
in the following formula:





The display will show, in order, the firmware revision numbers (

r 1 0 0).

Exit programming mode

 once or twice.
If, for example,  is pressed while a value is being programmed, or after  is pressed, the dialer returns to
the standby state. However, if  is pressed when the display shows the letter P, the dialer will exit programming
To exit programming mode at any moment, press the key

mode.
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PROGRAMMING
If an invalid key is pressed during programming operations, the speaker will emit the classic error sound (boop).
In all other cases, it will emit a normal sound (beep).
For a complete and detailed description of all parameters, consult the "PROGRAMMING BY PC" chapter.

Change Installer PIN
The Installer PIN can be changed at any time (it is factory set at 0001). Change the Installer PIN by entering
programming mode and entering the following formula::



 <New Installer PIN> 

where <New Installer PIN> is a number 4 to 6 digits long.

Programming telephone numbers
The dialer can store 8 telephone numbers, each up to 20 digits long. One-second pauses can be inserted into
every telephone number: for example, a pause can be inserted between the number prefix and the number
itself.
The dialer is provided from the factory without any programmed telephone numbers. To program a telephone
number, refer to Tab. 3a.
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Telephone number options
Options can be programmed for each telephone number. Refer to Tab. 3b for a list of options. The dialer is
provided from the factory without any programmed options (0).
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Call attempts
Program the number of times a call is attempted for each programmed telephone number by entering the
following formula:

 <Number of attempts> 



where <Number of attempts> is a number between 1 and 9 (factory set at 1).

Bypass answering machine
Enable/disable Bypass answering machine by entering the following formula:





 (to disable bypass answering machine - factory setting)



   (to enable bypass answering machine)

Number of rings
Program the number of rings after which the dialer will answer an incoming call by entering the following
formula:

 <Number of rings> 



where <Number of rings> is a number between 1 and 9 (factory set at 3).

 If

the Bypass answer machine option is enabled, the dialer will ignore this parameter.

Tone on PSTN fail
Enable/disable notice of telephone line failure by entering the following formula:





 (to disable the tone - factory setting)



   (to enable the speaker tone)

Tone check
Enable/disable DTMF tone check by entering the following formula:




   (to enable Tone check - factory setting)
    (to disable Tone check)

Pulse dialling
Select the pulse/tone dialing by entering the following formula:





 (to select tone dialing- factory setting)



   (to select pulse dialing)

Call all voice messages numbers
Enable/disable the option to call all voice numbers by entering the following formula:





 (to disable the option - factory setting)



    (to enable the option)

Call all telemonitoring numbers
Enable/disable the option to call all Telemonitoring numbers by entering the following formula:





 (to disable the option - factory setting)



    (to enable the option)
17
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Confirm call result
Enable/disable voice call confirmation by entering the following formula:





 (to disable voice call confirmation - factory setting)



   (to enable voice call confirmation)

 If

voice call confirmation is disabled, message playback will begin after the Start playing after ‘Delay’ time
has elapsed (see the following paragraph). When voice call confirmation is instead enabled, message
playback will begin after a voice response is received from the remote user.

If this option is enabled (value 1), the remote user will send confirmation by pressing the
telephone keypad (valid only for touch tone telephones).

 key of the remote

Start playing after ‘Delay’
Program the delay after which the dialer begins voice message playback by entering the following formula:



  <Delay> 

where <Delay> is a number between 0 and 240 seconds (factory set at 0, no delay).

Start playing after ‘Voice on-line’
Enable/disable voice call confirmation by entering the following formula:





 (to disable voice call confirmation - factory setting)



    (to enable voice call confirmation)

Start playing after ‘Selection’
Set on to "0" the two previous options to play the message immediately after the end of the selection, as
indicated below:





 (Start playing after 'Delay' = 0 secs.)





 (Disable the playing after 'Voice on Line')

One way audio
Select the listen-in mode by entering the following formula:







    (to enable listen-in mode)

4 Channel telephone dialler

 (to disable listen-in mode – factory setting)
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Alarm events and actions
When an alarm event occurs (alarm channel, failure, superkey is pressed, etc.) the dialer can perform up to 8
calls, send up to 3 voice messages, and/or can send a code to the electronic surveillance company.
Tab. 3d, 3e, and 3f describe these types of settings.
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Restore events and actions
When an alarm event is restored (for example, alarm channel, failure, etc.) the dialer can perform up to 8 calls,
send up to 3 voice messages, and/or send a code to the electronic surveillance company.
Tab. 3g, 3h and 3i, describe this type of programming.
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Telemonitoring user PIN
If the electronic surveillance option is associated with a telephone number (options #2 - #9 of Tab. 3b), a User
PIN must also be programmed. This PIN is hexadecimal (alphanumeric) and is 4 digits long (5 for CESA
protocol). The dialer is provided from the factory without any programmed User Codes.
To program the electronic surveillance User PIN, refer to Tab. 3c.



#$#
#$%
#$
#$&
#$'
#$(
#$)
#$$










  


 
 
 @
 
 
 ?
  A

   

!"


  

? 


@ 

  C

         
! "#?@ #

  $   % $ &'()  
!* @+*#@*,! " ?A#

Input Activation Mode
To program the activation mode of the 4 inputs, consult Table 3m. For further information, consult the ACTIVATION
POLARITY paragraph in the INSTALLATION chapter.
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Stop alarm channel
It is possible to program one of the four channel inputs to perform the 'Stop Alarm' function as described in
Table 3n. For further information, consult the 'Auxiliary connections' paragraph of the INSTALLATION chapter
and the 'Stop Alarm' paragraph in the OPERATING YOUR SYSTEM chapter.
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Outputs
It is possible to program outputs to respond to one or more events. Moreover, each output can be programmed
as 'Monostable' or 'Bistable'. The following Tab. 3o and 3p describe, respectively, how to program Outputs 1
and 2.
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Voice Message Settings
Before recording messages, set message duration and number of messages by entering the following formula:



 <Message Number/Duration> 

where <Message Number/Duration> is a number between 0 and 4:
= two messages, each 32 seconds long (factory setting);
= four messages, each 16 seconds long;

 = one 32 second long message and four messages, each 8 seconds long;
 = eight messages, each 8 seconds long.
Record Voice Messages
Follow this procedure to record voice messages:
1. Press the

 key;

2. Key in the number
3. Press the





followed by the number of messages that will be recorded (from

key.

At this time, any message previously recorded will be ERASED.

4. Wait until the display shows the dash

-;

5. Move near the microphone [2] shown in Fig. 1 and press the
show the number of seconds left until the end of the message;



 to );

If you wish to interrupt message recording, press the

key to begin recording. The display will

key.

6. Record additional messages, as necessary, by repeating the procedure from Step 1.

Repeat Voice Messages
To program the number of repetitions for all voice messages, enter the following formula:



 <Number of repetitions> 

where <Number of repetitions> is a number between 1 and 9 (factory set at 1: a voice message will be sent only once).
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OPERATING YOUR SYSTEM
CAUTION - Operation of the B-TEL2 is guaranteed only if a qualified professional installs and programs
the device.
In the event of an alarm, all telephone devices connected after the dialer are isolated for the time
necessary to undertake the cycle of programmed calls. To restore the telephone line, interrupt the alarm
cycle as described in the "Stop Alarm by Keypad" paragraph.

G

ALS
SIGNALS
DISPLAY
Y SIGN
DISPLA
The dialer display is normally turned off in a non-operating state. However, the occurrence of any malfunctions
will immediately be revealed on the display by a letter, as described in the following (in order of priority, in the
event that several malfunctions are present simultaneously):

b = Battery level low.
r = External power failure.
t = PSTN telephone line failure.
OPERATIONS
KEYPAD
TIONS
AD OPERA
KEYP
NOTE - It is necessary to enter the User Menu in order to perform KEYPAD OPERATIONS.

Acces User Menu
Access the User Menu key by entering the following formula:

 <User PIN> 
where <User PIN> is a number 4 to 6 figures long (the User PIN is factory set at 0002).
When the User Menu is accessed, the letter

U will be shown on the display.

 If an incorrect PIN or a PIN longer than 6 figures is entered, the speaker will emit an error sound (boop).
 If

5 minutes elapse without a key being pressed at any point in the programming process, the dialer will
automatically exit out of the User Menu.

To exit the User Menu in advance, press the

 key when the display shows the letter U.

Change User PIN
Change the User PIN (factory set at 0002) by entering the following formula:



  <New PIN> 

where <New PIN> is a number 4 to 6 digits long.

Stop Alarm by keypad
Once an alarm situation has been detected, or in cases of a false alarm, the telephone dialer (and therefore
any calls, including those already underway) can be stopped by access the User Menu and pressing the
key on the keypad.



It is also possible to dedicate an alarm channel specifically to the Stop Alarm function. Ask the installer to
perform the wiring required for this option.
To ensure that the dialer has effectively performed the Stop Alarm, press the keypad keys. If the display remains
off, the function was successfully completed. If not, key in the Stop Alarm code again.

4 Channel telephone dialler
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Responder
Enable or disable the responder by entering the following formula:





 



   

(disable responder, factory setting)
(enable responder)

Reading the event register (Logger)
A list of the last 255 events (alarms, superkeys, restores, failures, etc.) can be viewed on the display.
Access the event register by entering the following series of keys:


At this point, the standby character
first; press



_ will appear on the display. Press  to see events from most recent to

to view events from first to last.



Each time the
and
keys are pressed, the display will show, in sequence, 3 characters. These event
codes are explained in Tab. 4.

 The INSTALLER is also able to read the Logger entering the user menu with his own code and following the
procedure described in this paragraph.

  2



$(+  +$3$+ "!#









 



 "$


9 1
9 1
%&'*$
%&'*
&19$
&19(
& %7:7 (
) $
) "

Activate/deactivate outputs
Activate or deactivate the dialer outputs by entering the following formula:

      (to activate Output #1)
 

 (to deactivate Output #1)



   (to activate Output #2)





 (to deactivate Output #2)
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SUPERKEY
S
SUPERKEYS
The dialer has 3 superkeys available, of which one (Key
For a description of superkey function, consult Tab. 5.
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REMO
TE OPERA
TIONS
REMOTE
OPERATIONS
The user can perform other operations from a remote touch-tone telephone.
In order to perform remote operations, the remote operations menu (also called the DTMF menu) must be
accessed. Enter the following formula on the remote telephone keypad:

 <User PIN> 

At least one of the following conditions is necessary in order to enter the remote operations menu:

Â
Â

A voice call is received from the dialer. In this case, the menu can be entered while the message is
being played back, before the dialer ends communication.
The 'Responder' option, as described in the KEYPAD OPERATIONS paragraph, is enabled. In this
case, the user will call the dialer from a remote telephone and access the remote operations menu
when the dialer responds.

If the entered PIN is valid, a confirmation beep will sound and the DTMF menu will be accessed. The following
operations can be performed from remote access:
z Check the status of the inputs
z Activate/deactivate outputs
z Stop alarm and cancel telephone queue
z Voice functions
Once the DTMF menu is entered, after tone confirmation, the operations listed in Tab. 6 can be performed by
pressing two keys in order:
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